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All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use 
with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options 
or any consumable products other than those designated as Original EPSON Products or EPSON Approved 
Products by SEIKO EPSON CORPORATION.

EPSON, EPSON Stylus, and ESC/P are registered trademarks and ESC/P Raster is a trademark of SEIKO EPSON 
CORPORATION. 

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Copyright © 1997 by Epson America, Inc. 4007083
4/97
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FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio or television reception. 
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does 
cause interference to radio and television reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or more of the following measures.

◗ Reorient or relocate the receiving antenna. 

◗ Increase the separation between the equipment and receiver.

◗ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

◗ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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Introduction

Your EPSON Stylus® Photo printer is the ideal output device for 
full-color layout proofs, digital photography, photo editing—or 
any imaging project you create on your computer. The printer 
includes the following features:

◗ Exclusive Micro Piezo ink jet technology for smaller, 
cleaner dots

◗ Six-color printing for photo reproduction quality on plain 
paper or a variety of special media

◗ Fastest color print speeds in its class

◗ Compatibility with Microsoft® Windows® and Macintosh®

◗ PhotoEnhance for optimizing the contrast, saturation, and 
brightness of your pictures at the touch of a button

◗ Resolutions up to 720 × 720 dpi

◗ EPSON Digital Darkroom software, inclucing Live 
Picture® (Macintosh), LivePix™ (Windows 95), and an 
outstanding collection of CD-ROM images
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Windows System Requirements
To use your printer and its software with a PC, your system 
should have:

◗ An IBM® compatible PC with at least a 486 DX2/66 MHz 
or faster processor 

◗ DOS, Windows 3.1x, Windows for Workgroups 3.11, or 
Windows 95

◗ At least 16MB of RAM 

◗ At least 50MB of free hard disk space for storing images 

◗ VGA, Super VGA, or better display adapter and monitor

◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended)

◗ A shielded, twisted-pair parallel cable (6 to 10 feet long) to 
connect your computer to the printer; the cable must have 
a D-SUB, 25-pin, male connector for your computer and a 
36-pin, Centronics® compatible connector for the printer.

Macintosh System Requirements
To use your printer and its software with a Macintosh, your 
system should have:

◗ Any Macintosh or Power Macintosh model except the 
Macintosh Classic, Macintosh +, Macintosh 512, or 
PowerBook™ 100

◗ System 7.1 or later

◗ At least 16MB of built-in RAM 

◗ At least 50MB of free hard disk space for storing images 

◗ VGA (8-bit, 640 × 480) or better display adapter and 
monitor

Note:
If you don’t have a 
CD-ROM drive, you can 
get the printer driver 
software on diskettes or 
download it through 
your modem. Contact 
EPSON as described on 
pages 4 and 5.

intro.fm5  Page 2  Friday, April 4, 1997  8:25 AM



Introduction

3

◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended)

◗ Standard Apple® System Peripheral-8 cable or equivalent 
(RS-422, 8-pin mini DIN male/male, Belkin F2V024 
recommended)

How To Use Your Manuals
To set up your printer, see the Quick Setup guide. This User’s 
Guide contains the following information:

Chapter 1 covers the basics of printing with Windows or 
Macintosh.

Chapter 2 tells you how to print special projects with custom 
settings for print quality and color management.

Chapter 3 gives guidelines for selecting and using the right 
paper or other media for your print job and instructions for 
printing panoramic images.

Chapter 4 explains how to manage print jobs, check printer 
status, and set up your PC system for network printing.

Chapter 5 gives instructions for replacing ink cartridges, 
cleaning and aligning the print heads, and cleaning and 
transporting the printer.

Chapter 6 provides solutions for any problems you may have.

The Appendix provides the technical details on your printer, 
ink cartridges, and EPSON media.

A Glossary and an Index are included at the end of the book.
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Warnings, Cautions, Notes, and Tips

You’ll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.

Where to Get Help
EPSON provides customer support and service through a 
network of authorized EPSON Customer Care Centers. Dial 
(800) 922-8911 for the nearest location or the following 
services:

◗ Fax-on-Demand access to EPSON’s technical information 
library 

◗ Literature on current and new products

◗ The location of your nearest Authorized EPSON Reseller or 
Customer Care Center 

◗ Technical information on the installation, configuration, 
and operation of EPSON products

◗ Customer relations

For answers to commonly asked questions about EPSON 
products 24 hours a day, seven days a week, call EPSON Sound 
Advice at (800) 442-2110.
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You can purchase ink cartridges, paper, manuals, accessories, 
and parts from EPSON Accessories at (800) 873-7766 (U.S. 
sales only). In Canada, please call (800) 873-7766 for dealer 
referral.

If you need help using software with an EPSON product, see 
the documentation for that program for technical support 
information.

Electronic Support Services

You can access helpful tips, specifications, DIP switch or 
jumper settings, drivers, FAQs, sample files, application notes, 
and EPSON product bulletins 24 hours a day, seven days a 
week, using a modem and one of the online services below.

World Wide Web

From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com. 

EPSON Internet FTP Site

If you have Internet FTP capability, use your Web browser (or 
other software for FTP downloading) to log onto 
ftp.epson.com with the user name anonymous and your e-mail 
address as the password.

EPSON Download Service

You can call the EPSON Download Service at (800) 442-2007. 
Set your communications software to 8 data bits, 1 stop bit, no 
parity. Modem speed can be up to 28.8 Kbps. 
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EPSON Fax-on-Demand Service

You can access EPSON’s technical information library by 
calling (800) 442-2110 or (800) 922-8911 and selecting the 
appropriate phone option. You must provide a return fax 
number to use Fax-on-Demand.

EPSON Forum on CompuServe 

Members of CompuServe® can type GO EPSON at the menu 
prompt to reach CompuServe’s Epson America Forum. As an 
owner of an EPSON product, you are eligible for a free 
introductory CompuServe membership, which entitles you to 
an introductory credit and your own user ID and password. 
To take advantage of this offer in the U.S. or Canada, call 
(800) 848-8199 and ask for representative #529. 

ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency.

The EPA ENERGY STAR Office Equipment program is a 
voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient 
personal computers, monitors, printers, fax machines, and 
copiers in an effort to reduce air pollution caused by power 
generation. 
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Energy-saving Tips

Here are a few tips you can use to be even more energy-wise:

◗ If your monitor isn’t ENERGY STAR compliant, turn it off 
when you’re not using it.

◗ Turn off your computer, printer, and monitor each day 
when you are done using them.

◗ Use the print preview option in your software so you can 
catch errors before you print something.

◗ Send e-mail rather than distributing memos. Not only is 
this faster, but you’ll save paper and storage space too.

Important Safety Instructions
Before using your printer, read the following safety instructions 
to make sure you use the printer safely and effectively.

◗ Turn off and unplug the printer before cleaning. Clean 
with a damp cloth only. Do not spill liquid on the printer.

◗ Do not place the printer on an unstable surface or near a 
radiator or heating vent.

◗ Do not block or cover the openings in the printer’s cabinet 
or insert objects through the slots.

◗ Use only the type of power source indicated on the printer’s 
label.

◗ Connect all equipment to properly grounded power 
outlets. Avoid using outlets on the same circuit as 
photocopiers or air control systems that regularly switch 
on and off.

◗ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche 
peut être débranchée facilement.
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◗ Do not let the power cord become damaged or frayed.

◗ If you use an extension cord with the printer, make sure 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total of all devices plugged into the wall 
outlet does not exceed 15 amperes.

◗ Except as specifically explained in this User’s Guide, do not 
attempt to service the printer yourself.

◗ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions: 

If the power cord or plug is damaged; if liquid has entered 
the printer; if the printer has been dropped or the cabinet 
damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those 
controls that are covered by the operating instructions.

Even if you are familiar with other types of printers, be sure to 
read through the following list of precautions before operating 
your ink jet printer:

◗ Do not put your hand inside the printer or touch the 
cartridge during printing.

◗ Under normal circumstances, ink will not come out of the 
cartridge. If it does get on your skin, wash it off with soap 
and water. If it gets in your eyes, flush them immediately 
with water.

◗ Keep ink cartridges out of the reach of children.

◗ Do not dismantle the ink cartridges or try to refill them. 
This could result in damage to the print head.

◗ Once you install an ink cartridge, do not open the clamp or 
remove the cartridge except to replace it with a new one. 
The cartridge may become unusable otherwise.

◗ Install the ink cartridge immediately after you remove it 
from its package. Leaving the cartridge unpacked for a long 
time before use may result in reduced print quality.

intro.fm5  Page 8  Friday, April 4, 1997  8:25 AM



Introduction

9

◗ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

◗ Do not shake an ink cartridge; this can cause leakage.

◗ Always turn the printer off using the Ppower button. 
When this button is pressed, the Ppower light flashes 
briefly then goes out. Do not unplug the printer or turn off 
the power to the outlet until the Ppower light is off.

◗ Before transporting the printer, make sure the print head is 
capped in the far right position and the ink cartridges are in 
place.
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It’s easy to print with your new EPSON Stylus Photo. First you 
have to set up your printer, following the instructions in the 
Quick Setup guide. Then install the printer driver software on 
your Digital Darkroom CD. Read this chapter to find out 
about the following:

◗ Printing from Windows

◗ Printing from a Macintosh

◗ Choosing paper and other media

◗ What to do when the printer lights flash

Printing from Windows
When you want to print from your Windows application, you 
click the print icon or choose Print from the File menu. You 
can then choose which pages to print, the number of copies, 
and other options. The settings that describe your print job—
whether you want to use full color or black ink only, for 
example—are part of your printer driver software. 

The following sections tell you how to set printer options from 
Windows applications, how to change the default printer 
settings, and how to check your printer’s status.

Basic Printing

Note:
If you need driver 
software for Windows 
NT and it’s not included in 
your box, you can 
download it from EPSON. 
See page 5 in the 
Introduction for more 
information. 
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Setting Printer Options from Windows 
Applications

This section describes the preferences you’ll need to set for all 
your everyday printouts. See Chapter 2 for information about 
special settings like PhotoEnhance. 

Follow these steps to check printer settings from your graphics 
application or other Windows software:

1. Choose Print or Print Setup from the File menu. You see a 
printing dialog box.

If you choose Print, you first see a Print dialog box that 
contains the settings you change most often, including the 
number of copies and the pages you want printed. 

2. Make sure your EPSON Stylus Photo printer is selected, 
and then click the Printer, Setup, Properties, or Options 
button. (You may have to click a combination of these 
buttons.) You see a dialog box like the following:

If you don’t see the dialog box shown in step 2, click the 
Main tab.

For more information 
about printer settings, 
click the Help button. In 
Windows 95, you can 
right-click any item on the 
screen and then click 
What’s This?

Click for 
more 
information

Main tab
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3. Make sure the Mode option is set to Automatic. The 
printer software determines the best settings for your print 
job. This is the easiest way to get good printing results on 
all types of paper.

4. Choose the Media Type you want to print on from the 
following list (you may need to scroll through the list). If 
you are not sure which setting to select, refer to the table on 
page 3-2.

◗ Plain paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of media you choose determines the print quality 
or resolution you can use.

5. Choose Color or Black ink. If you’re printing grayscale 
images, choose Black for faster output.

6. Set the slider to Quality or Speed. This lets you choose 
between the highest resolution or the fastest printing for the 
media you’re using. (The slider is not available for certain 
media types.)

7. If necessary, click the Paper tab and choose your paper size, 
number of copies, and orientation. If your software 
application lets you control these settings, you don’t need 
to use the Paper tab.

8. Click OK when you’re finished checking your settings. 

9. In the printing dialog box, click Close, OK or Print. You 
may need to click a combination of these buttons. 

While your document is printing, the EPSON Despooler 
dialog box appears, showing the printing progress and the 
status of your printer. (See page 1-5 for more information.)

If you click Advanced 
instead of Automatic, 
you can choose 
PhotoEnhance from 
the list of modes. See 
Chapter 2 for more 
information.
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Setting Default Printer Options

When you change printer settings through your software 
application, the settings apply only to the application you’re 
using. If you want to adjust the default settings for all your 
Windows applications, you can access the dialog box through 
the Windows 95 Settings option or the Windows 3.1 Control 
Panel. 

Make sure all your software applications are closed before you 
start. If not, you’ll have to close and then reopen them to have 
the new default settings take effect.

Setting Default Options in Windows 95

Follow these steps: 

1. Click Start, point to Settings, and then point to Printers. 

2. Right-click the EPSON Stylus Photo icon. 

3. Select Properties. Then click the Main tab. 

You see the Main printer settings dialog box, as shown on 
page 1-2. Any changes you make will become the default 
settings for all your applications and documents. 

Setting Default Options in Windows 3.1 

Follow these steps: 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus Photo from the list of printers and 
click Setup. 

You see the Main printer settings dialog box, as shown on 
page 1-2. Any changes you make will become the default 
settings for all your applications and documents. 

Note:
Some application settings 
override printer settings 
(such as Paper Size or 
Orientation), so it’s a 
good idea to check 
the settings in your 
application before 
you print.
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Checking Printer Status

While your document is printing, the EPSON Despooler dialog 
box appears on your screen:

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper while printing, for 
example, the Despooler warns you. You can use the buttons to 
cancel, pause, or restart your print job. 

The Status Monitor at the bottom of the dialog box shows how 
much ink is left in your printer, along with these status icons:

The name of 
the file you’re 
printing 
appears here

Click to 
pause printing

Click to cancel 
printing

Click to 
restart printing

Note:
The Status Monitor 
appears only if you’re 
using Windows 95 and 
you’re not printing over 
a network.

The Status Monitor is checking the printer’s 
status.

An error has occurred. Check your printer or see 
Chapter 6 for troubleshooting information.

The printer is ready to print.

The printer is currently printing.

The ink level is low or empty; check the B or A 
Ink Out light on the control panel and replace the 
cartridge if necessary.
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Printing from a Macintosh
When you set up a new printer for your Macintosh, you need to 
check the page setup for documents in each application you use. 
You can then click the print icon or choose Print from the File 
menu. You see a dialog box that lets you choose the settings that 
describe your print job.

This section describes the preferences you’ll need to set for all 
your everyday printouts. See Chapter 2 for information about 
special settings like PhotoEnhance. 

Follow these steps to check printer settings from your word 
processor or other Macintosh application:

1. Choose Page Setup from the File menu. You see the Page 
Setup dialog box.

2. Choose your paper size and other page setup options and 
click OK.

3. Choose Print from the File menu or click the print icon in 
your application. You see a dialog box like the following:

4. Choose the number of copies and indicate which pages you 
want to print.

Note:
On the Macintosh, printer 
settings are saved with 
your document, but you 
can’t save them from one 
application to another. 
You’ll have to check your 
settings each time you 
print from a new 
application. If you want to 
reuse settings, you can 
create document 
templates for your favorite 
applications.

Click for more information 
about printer settings

Click to see list 
of media types
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5. Make sure the Mode option is set to Automatic. The 
printer software determines the best settings for your print 
job. This is the easiest way to get good printing results on 
all types of paper.

6. Choose the Media Type you want to print on from the 
following list. If you are not sure which setting to select, 
refer to the table on page 3-2.

◗ Plain Paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of media you choose determines the print quality 
or resolution you can use. 

7. Choose Color or Black ink. If you’re printing grayscale 
images, choose Black for faster output.

8. Set the slider to Quality or Speed. This lets you choose 
between the highest resolution or fastest printing for the 
media you’re using. (The slider is not available for certain 
media types.)

9. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing. See “Using Monitor2” in Chapter 4.

If you click Advanced 
instead of Automatic, 
you can choose 
PhotoEnhance from 
the list of modes. See 
Chapter 2 for more 
information.
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Choosing Paper and Other Media
You can use most types of paper with your printer, but you’ll 
get better results with specially designed EPSON ink jet paper or 
other media. Following is a list of the media available for 
EPSON ink jet printers. See Chapter 3 for more information on 
using special paper and other materials.

To order EPSON papers and other media, contact your dealer 
or call EPSON Accessories at (800) 873-7766 (U.S. sales only). 
In Canada, please call (800) 873-7766 for dealer referral.

Media name Size Part number

EPSON 360 dpi Ink Jet Paper A4
Letter

S041059
S041060

EPSON High Quality Ink Jet 
Paper

Letter S041111

EPSON Photo Quality Ink Jet 
Paper

A4
Letter
Legal

S041061
S041062
S041067

EPSON Photo Quality Glossy 
Paper

A4
Letter

S041126
S041124

EPSON Photo Quality Glossy 
Film

A4
Letter

S041071
S041072

EPSON Photo Paper 4 × 6 S041134

EPSON Ink Jet Transparencies A4
Letter

S041063
S041064

EPSON Photo Quality Ink Jet 
Cards

A6
5 × 8
10 × 8

S041054
S041121
S041122

EPSON Iron-On Transfer Paper Letter
Letter

S041001 (10 sheets),
S041002 (50 sheets)

EPSON Photo Quality Self 
Adhesive Sheets

A4 S041106
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What To Do When the Printer 
Lights Flash

The four lights on your printer’s control panel show the 
printer’s status and alert you to problems like paper jams. 

power light

black ink 
out light

paper light

color ink 
out light

load/eject
button

cleaning
button

power 
button

S When the paper light comes on, your paper ran out or is 
incorrectly loaded. Load paper in the feeder and then press the 
E load/eject button. 

B A When an ink light comes on, you need to replace the ink 
cartridge. See Chapter 5 for instructions.

B A When an ink light flashes, your ink supply is low. Make sure 
you have a replacement cartridge.

S B A When the paper light flashes and the ink out lights are on, you 
have a paper jam. Turn off the printer and gently pull out all 
jammed paper. Then press the E load/eject button. 

P The power light is on when the printer is on. The power light 
flashes when the printer is receiving a print job or performing a 
maintenance operation.

P S B A When the power and paper lights flash and the ink out lights 
are on, your printer has a carriage error. Press the P button 
twice to reset the printer. See Chapter 6 for more information. 

P S B A When all the lights flash, your printer may have an internal 
error. See Chapter 6 for more information. 
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When your photographs or other projects have special printing 
requirements, you can use the custom settings in your EPSON 
Stylus Photo software. You can choose predefined settings like 
PhotoEnhance or adjust individual options like brightness, 
contrast, saturation, and halftoning. For professional-quality 
color accuracy, you can use Image Color Matching (ICM) 
under Windows 95 or ColorSync™ on the Macintosh.

This chapter includes the following information:

◗ Using predefined advanced settings

◗ Customizing print quality and special effects

◗ Customizing color settings

◗ Using ColorSync on the Macintosh

◗ Saving custom settings

Using Predefined Advanced 
Settings
Predefined settings provide an easy way to enhance your photos 
and fine-tune your printer’s operation. Follow these steps to 
print with predefined settings:

1. Create your image or project in your application software.

2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-6 (Macintosh).

Custom Printing
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You see one of the following dialog boxes:

Note:
When you use 
advanced settings, 
the Quality/Speed 
slider disappears.

Windows

Click Advanced, then click here 
to see a list of project types

Macintosh

Click Advanced, then click here 
to see a list of project types
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3. Select Color or Black Ink.

4. Click Advanced, and then Custom Settings. You see the 
list of project types.

5. Follow these guidelines to choose the right setting for your 
project:

◗ Photo
For printing scanned photographs with increased 
contrast.

◗ Text/Graph
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ PhotoEnhance
Produces sharper images and more vivid colors by 
automatically adjusting the contrast, saturation, and 
brightness. Corrects for under- and over-exposure of 
the original image.

◗ Text
For faster printing of text-only documents on plain 
paper. 

◗ Economy
For rough drafts of text only, on plain paper. Saves ink.

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to match the 
colors on your screen.

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match the 
colors on your screen. For more information, see 
page 2-9.

6. Choose the Media Type you want to print on. (If you’re 
not sure which setting to select, refer to the table on 
page 3-2.) The available media are limited by the project 
you choose. For example, you can’t use plain paper or 
transparencies with the ICM or ColorSync settings.

The Photo setting and the 
PhotoEnhance setting 
have similar effects. 
However, PhotoEnhance 
intelligently analyzes your 
image data, and its effect 
varies widely depending 
on your image.The Photo 
setting consistently 
increases contrast. You 
may have to experiment 
to choose the best setting 
for your needs.
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7. If you’re printing on envelopes, EPSON Photo Paper, or 
other special-size media, make sure you select the correct 
paper size. If you’re using Windows, click the Paper tab. If 
you’re using a Macintosh, choose Page Setup from the file 
menu of your application. See Chapter 3 for more 
information about printing on special media.

8. Click OK or Print. If you’re using Windows, click any 
other buttons that your application uses for printing.

Customizing Print Quality and 
Special Effects
If you need the maximum control over your photos, or you 
want to experiment with special effects, you can adjust 
individual settings in your printer software. Follow these steps:

1. Create your image or project in your application software.

2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-6 (Macintosh). 

3. Click Advanced, and then click More Settings. You see 
the More Settings dialog box:

Note:
After you customize your 
print settings for a special 
project, you can save 
them as a group. Then 
you can reuse them 
whenever you print a 
similar project. See 
page 2-11 for instructions.

Some of these options 
are automatically set or 
disabled by other settings 
you choose
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4. Choose one of the following Print Quality options:

◗ Economy
For low-resolution rough drafts on plain paper. Saves 
ink.

◗ Normal - 360 dpi
For printing on plain paper, transparencies, or 360 dpi 
Ink Jet paper.

◗ Fine - 720 dpi
For the highest-resolution output. Works best on 
photo quality media.

5. Choose the Media Type and Ink settings you want to use, 
following the guidelines in Chapters 1 and 3. 

6. Choose one of the following Halftoning options:

◗ No Halftoning
For black text only.

◗ Error Diffusion
For photographic images. Blends each dot of color with 
surrounding dots.

◗ Fine Dithering
For charts, graphs, and other images that require 
precise, solid areas of bright colors. Arranges dots in 
orderly patterns. 

Macintosh

Note:
The Print Quality option 
you choose limits your 
choice of Media Types. 
Be sure to check both of 
these settings.

Some of these options 
are automatically set 
or disabled by other 
settings you choose
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7. Choose any of the following options. Some of these settings 
are automatically selected or disabled by the Print Quality 
(resolution) you choose.

◗ MicroWeave
For improved print quality. Prints graphic data in finer 
increments to eliminate unwanted banding effects 
(light horizontal lines). Always use for color printing.

◗ Super MicroWeave
Use with Photo Quality media if MicroWeave doesn’t 
completely eliminate banding in your printout. 
Printing is slower.

◗ High Speed
For fast, bidirectional printing at lower quality.

◗ Flip Horizontal
Prints a mirror image of your document. Use for 
printing with iron-on transfer paper. When you iron 
the printout onto a T-shirt or other item, it will read 
correctly.

◗ Finest Detail
For printing text, graphics, and line art with very sharp 
edges. Slows print speed and increases your system 
memory requirements. 

8. Click OK if you’re ready to print, or see the next section if 
you want to adjust your printer’s color settings.

If vertical lines in your 
printout are misaligned 
when you use the High 
Speed setting, you may 
need to align the print 
heads. See Chapter 5 for 
instructions.
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Customizing Color Settings
You can choose from several color adjustment modes or 
manually adjust brightness, contrast, and saturation. For 
professional color correction, you can set individual CMY color 
values. To achieve the maximum color accuracy, you can use 
Image Color Matching (ICM) under Windows 95 or 
ColorSync on the Macintosh.

Follow these steps to customize your color settings:

1. Access the More Settings dialog box as described on 
page 2-4.

The color settings appear on the right side of the dialog 
box, as shown:

Click to set Color Adjustment Mode

Drag sliders to 
set values 
between -25% 
and +25%

Macintosh

Windows 
(ICM is available only for Windows 95)
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2. Choose one of the following Color Adjustment Modes:

◗ Automatic
Analyzes the color information in your image and 
optimizes color correction accordingly.

◗ Photo-realistic
For increased contrast in color photographs. 

◗ Vivid
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ No Color Adjustment (Macintosh only)
Choose this mode only if you’re using ColorSync.

3. If you want to specify individual color correction values, 
use the sliders to increase (drag right) or decrease (drag left) 
the settings listed below. (If you want to use the options 
described in step 4, you won’t be able to specify individual 
color correction values.)

◗ Brightness
Makes your image lighter or darker.

◗ Contrast
Increases or decreases the difference between the bright 
or dark parts of an image.

◗ Saturation
Makes colors more vivid or less vivid.

◗ Cyan, Magenta, Yellow
Increases or decreases individual color values. The 
Cyan and Magenta settings also affect the light cyan 
and light magenta inks. Use these sliders to fine-tune 
the color balance in your printout.

The Photo-realistic 
setting and the 
PhotoEnhance setting 
have similar effects. 
However, PhotoEnhance 
intelligently analyzes your 
image data, and its effect 
varies widely depending 
on your image. 
Photo-realistic 
consistently increases 
contrast. You may have to 
experiment to choose the 
best setting for your 
needs.
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4. For even more fine-tuning, choose PhotoEnhance, ICM 
(Windows 95), or ColorSync (Macintosh).

◗ PhotoEnhance
Produces sharper images and more vivid colors by 
automatically adjusting the contrast, saturation, and 
brightness. Corrects for over- or under-exposure of the 
original photograph.

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to match colors 
on the screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match colors 
on the screen. See “Using ColorSync on the 
Macintosh” for more information.

5. Click OK to return to the Main printer settings dialog box.

6. Click Save Settings if you want to save your custom 
settings as a group that you can reuse for special projects. 
See page 2-11 for more information about saving settings.

7. Click OK (Windows) or Print (Macintosh). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

Using ColorSync on the Macintosh
Every device you use for viewing or producing colors—your 
monitor, scanner, and printer—uses a different color 
technology. That’s why it’s difficult to get printed colors to 
match the colors displayed on your monitor. 

Each device has its own gamut, or range of colors that it can 
reproduce. The Macintosh ColorSync system translates colors 
from one gamut to another so your monitor’s colors match your 
printer’s as closely as possible. 

Note:
When you choose 
PhotoEnhance, ICM, or 
ColorSync, all the other 
color options are preset.
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ColorSync uses profile information from each device—
including your EPSON Stylus Photo—to achieve accurate color 
matching. First you have to make sure your monitor’s profile is 
set. Then you can use your printer software to specify the exact 
method of gamut mapping (color matching) you want to use.

Follow these steps to set your monitor’s ColorSync profile and 
use your printer software’s ColorSync features:

1. Open ColorSync System Profile under Control Panels 
on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.

4. Close ColorSync System Profile.

5. Access the More Settings dialog box as described on 
page 2-4. 

6. Click ColorSync.

7. For Profile, choose EPSON Standard.

8. Choose one of the following options for Rendering Intent:

◗ Perceptual
Scales the displayed colors to fit within the printer’s 
gamut. Maintains the relationship between colors.

◗ Saturation
For printing graphics-intensive documents like 
presentation pages with charts and graphs (at Fine - 
720 dpi Print Quality on Photo Quality media only). 
Maintains the relative saturation of colors from one 
gamut to another.

◗ Colorimetric
For matching colors as precisely as possible (at Fine - 
720 dpi Print Quality on Photo Quality media only). 
Maintains colors that fall within the gamut of both the 
monitor and printer, but may lose some detail in areas 
where the colors are outside the printer’s density range.

Note:
The EPSON Standard 
profile is custom-
designed for your printer. 
If you use a scanner or 
other color imaging 
equipment, you may have 
other profiles available.
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9. Click OK, and then click Print.

Saving Custom Settings
After you’ve fine-tuned your printer settings for a special 
project, you can save your settings as a group. Then you can 
easily select the settings the next time you print a similar 
project. Follow these steps:

1. Customize your printer settings as described in this chapter.

2. Click the Save Settings button on the Main printer 
settings dialog box. 

You see one of the following:

 

3. Type a unique name for your settings (up to 16 characters) 
and click the Save button. The name you choose will now 
be available on the Main printer settings dialog box when 
you click Advanced, and then Custom Settings.

Note:
You can save up to 10 
groups of settings.

Macintosh

Windows
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Your EPSON Stylus Photo lets you print on just about any kind 
of paper you want to use. You can get great results printing on 
various sizes of plain paper, letterhead, and envelopes. You’ll get 
even better results with specially coated ink jet paper. For the 
best output, use EPSON’s Photo Paper or other photo quality 
media. 

For special projects, you can use a variety of EPSON media 
designed for ink jet printers, ranging from transparencies to 
iron-on transfer paper. You can even set up your printer to use 
custom paper sizes to print panoramic images. This chapter 
covers the following:

◗ Using special media

◗ Printing panoramic images and other custom size projects

Using Special Media
When you print on special media, you need to be careful about 
choosing the correct Media Type and Paper Size settings in 
your printer software. Use the table on the next page to help 
you match the paper or media you loaded in the printer with 
the Media Type setting in the software.

Printing on
Special Media
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The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. The following tips will help you get the best results on 
any type of paper or other media.

For this media name . . .

Select this Media Type 

setting . . .

Plain paper Plain paper

Envelopes Plain paper

EPSON 360 dpi Ink Jet Paper

EPSON Special Coated Paper for 
360 dpi Printing

360 dpi Ink Jet Paper

EPSON High Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Special Coated Paper for 
720 dpi Printing

EPSON Photo Quality Ink Jet Cards

EPSON 720 dpi Index Cards

EPSON Photo Quality Self 
Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Photo Paper

EPSON Photo Quality Glossy Paper

Photo Quality Glossy Paper

EPSON Photo Quality Glossy Film

EPSON High Quality Glossy Paper

EPSON Iron-On Transfer Paper

Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Letterhead, Pre-printed Forms, and 
Legal-size Paper

Always load the top edge first. 

If you’re loading legal-size paper, pull out the paper support 
extension.

EPSON 360 dpi, High Quality, and Photo 
Quality Ink Jet Paper

You can load paper up to the arrow mark on the left edge guide. 
If you use legal-size ink jet paper, don’t load it more than half 
way to the arrow mark.

Note:
When you load paper, 
make sure the printable 
side is facing up. Some 
special media have a cut 
corner that you need to 
position correctly; follow 
any instructions in the 
package. Always handle 
sheets by the edges, and 
don’t touch the printable 
surface.

Caution:
Don’t use the cleaning 
sheets that may be 
included with your special 
media; they may damage 
the printer.
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EPSON 4 × 6 Photo Paper

Photo paper (4 × 6) is perforated around the edges, so you can 
trim your printouts and “bleed” the photo—extend it to the 
edge of the paper—on all sides. Follow these steps to print on 
EPSON Photo paper:

1. Load the paper with the whiter side facing up and the 
perforated margins positioned as shown:

You can load up to 20 sheets of Photo paper at a time. 
Make sure you place the included support sheet beneath the 
stack, but don’t print on it.

2. Slide the left edge guide so it fits snugly against the paper.

3. When you create the image in your application software, 
size it to 4.25 × 6.25 inches. 

trim size

printed image size

.67 in

.24 in

.12 in

.24 in.12 in
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4. Choose EPSON Photo Paper 4 × 6 in as the Paper Size 
setting and Maximum as the Printable Area setting.

5. Choose Photo Quality Glossy Paper as the Media Type 
setting.

6. After you print your picture, fold the paper back and forth 
along the perforations and carefully tear the margins off.

To keep your printouts looking their best, store them in a 
resealable plastic bag or other airtight covering and protect 
them from heat, humidity, and direct sunlight.

EPSON Photo Quality Glossy Paper, Film, 
and Transparencies

Follow these steps to print on glossy media or transparencies:

1. To print on transparencies only, remove the paper support 
and reinstall it in the rear paper support slot, as shown 
below. For glossy paper and film, leave the paper support in 
the normal position.

Note:
Use ink jet papers within 
one year of purchase. 
Use glossy media and 
transparencies within six 
months. Return unused 
sheets and envelopes to 
their original package as 
soon as possible and avoid 
exposing them to heat, 
humidity, and direct 
sunlight. See the 
Appendix for more 
storage information.
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2. Before you load the media, place the included support sheet 
or a plain paper sheet beneath the stack. 

You can load up to 20 sheets of glossy paper, 30 sheets of 
glossy film, or 10 transparencies. However, you may get 
better results by loading one sheet at a time. With multiple 
sheets loaded, the minimum top margin you can use is 
1.2 inches. 

3. Make sure you load the media with the printable side facing 
up. If the sheets have a cut corner, position them as shown:

4. Remember to choose the correct Media Type setting in 
your printer software, following the guidelines on page 3-2.

cut corner
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Envelopes

You can load up to 10 envelopes at a time. Adjust the left edge 
guide and load the envelopes as shown, flap edge first and 
printable side up:

Set the thickness lever to the + position when you print on 
envelopes or if ink smears when you print on other thick media. 
Open the printer cover and position the lever as shown below. 
Then close the cover and print. (Make sure you return the lever 
to the 0 position before you print on thin media.)

Note:
Before you print, make 
sure you set the Paper 
Size option for the type of 
envelope you’re using. 
Set the Media Type to 
Plain paper.
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EPSON Photo Quality Ink Jet Cards

Use these cards to print photos, postcards, or greeting cards. 

You can load up to 30 cards at a time with the included support 
sheet or a sheet of plain paper beneath the stack. When you’re 
ready to print, use your software to set the Paper Size option 
for the size card you’re using and set the Media Type to Photo 
Quality Ink Jet Paper.

If ink smears on the cards, set the thickness lever to the + 
position as shown on page 3-7.

EPSON Iron-On Transfer Paper

You can print photos, company logos, or anything else you 
want on this paper, and then transfer your images to T-shirts or 
other cloth items. Load one sheet of transfer paper at a time, 
and set the Media Type option to 360 dpi Ink Jet Paper. 
After you print, follow the instructions that came with the 
paper to iron the image onto the shirt or other item.

EPSON Photo Quality Self Adhesive Sheets

Use these sheets to print labels or stickers. Load one sheet at a 
time, and set the Media Type option to Photo Quality Ink Jet 
Paper. Make sure your adhesive sheets are fully adhered to their 
backing sheet before you load them.

For iron-on transfers, 
make sure you reverse 
your image before you 
print it, especially if it 
includes text. Then the 
text will read correctly 
when it’s transferred. You 
can use the Flip 
Horizontal option in your 
printer software. 
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Printing Panoramic Images and 
Other Custom Size Projects
You can use banner paper or ordinary (continuous-form) 
computer paper to print an image up to 44 inches long. You 
can also print on any size paper that fits into the printer (at least 
3.94 × 3.94), by using the custom page size feature of your 
printer software on either a Windows computer or a Macintosh.

1. To make a 44-inch print with continuous-form computer 
paper, first tear off four sheets and remove the perforations 
at the edges. If you are using non-perforated banner paper, 
cut the paper to the length you want for easier handling.

2. Insert the paper in the printer as shown. The right edge of 
the paper should be against the right edge guide.

3. Slide the left edge guide next to the left edge of the paper.

4. Follow the instructions below to print your image on either 
a Windows computer or a Macintosh.
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Printing a Panoramic Image from Windows

Follow these steps to print a panoramic image or other 
custom-size project on a Windows computer:

1. Create the project in your graphics application or other 
software. You can create it in either portrait or landscape 
orientation. 

2. Click the print icon or choose Print or Print Setup from 
the File menu. You see a printing dialog box.

3. Make sure your printer is selected, and then click the 
Printer, Setup, Properties, or Options button. (You may 
have to click a combination of these buttons.) You see the 
Main printer settings dialog box, as shown on page 1-2.

4. Click the Paper tab. You see a dialog box like the 
following:

5. Choose User Defined from the Paper Size list.

Click to display 
list of paper sizes
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The following dialog box appears:

6. Type 8.5 inches for the Paper Width and any size up to 44 
inches for the Paper Height. (This works for both 
“landscape” and “portrait” style images.) Click OK.

7. Choose Portrait or Landscape if you haven’t already 
specified the orientation in your application software. Set 
the printable area if necessary.

8. Click the Main tab to return to the Main printer settings 
dialog box. Make sure you choose the appropriate media 
type and the other settings you want to use, and then click 
OK. 

9. Click Close, OK, or Print to print your image. You may 
need to click a combination of these buttons.

Printing a Panoramic Image from a 
Macintosh

Follow these steps to print a panoramic image or other 
custom-size project on a Macintosh:

1. Create the document in your graphics application or other 
software. You can create it in either portrait or landscape 
orientation. 

2. Choose Page Setup from the File menu. 

For panoramic 
printing, type any 
size up to 44 inches

If you’re using computer 
paper, choose Plain 
paper for the Media 
Type setting. If you’re 
using coated banner 
paper, try the Photo 
Quality Ink Jet Paper 
setting.
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You see a dialog box like the following:

3. Choose Portrait or Landscape, depending on the 
orientation you want. Set the printable area if necessary.

4. Click the Customize button. The following dialog box 
appears:

5. Click the New button. The dialog box changes:

6. Type a name for your custom size in the New Paper Size 
box. 

Click to display list of paper sizes

Click to define your 
own paper size

Click to 
create a new 
paper size

Type a name 
for your size 
here
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7. To print a panoramic image, type 8.5 inches for the Width 
and up to 44 inches for the Height. (This works for both 
“landscape” and “portrait” style images.) Click OK, then 
OK again.

8. Choose Print from the File menu or click the print icon in 
your application. You see a printer settings dialog box like 
the one shown on page 1-6. 

9. Make sure you choose the appropriate media type and the 
other settings you want to use, and then click Print to print 
your banner. 

If you’re using computer 
paper, choose Plain 
paper for the Media Type 
setting. If you’re using 
coated banner paper, try 
the Photo Quality Ink Jet 
Paper setting.
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Your printer software includes several utilities for managing 
print jobs. You can use them to monitor your printer’s status, 
set up large jobs to print later, and handle network printing. If 
you’re using your printer on a network, you need to follow 
special setup procedures. 

This chapter provides instructions for the following:

◗ Managing print jobs in Windows

◗ Managing print jobs on a Macintosh

◗ Network printing on a PC

Managing Print Jobs in Windows
Your Windows printer software includes two management 
utilities: the Spool Manager and Status Monitor. 

◗ The Spool Manager starts automatically when you send a 
job to the printer. It allows you to print in the background 
while you continue to work on your computer and to hold 
jobs to print at a later time. If you’re using your printer on a 
network, it also handles multiple print jobs that come in at 
the same time.

◗ The Status Monitor, which is available only if you’re using 
Windows 95, also starts automatically when you send a job 
to the printer. It displays on your screen to alert you about 
printer and ink status. 

Managing
Print Jobs and

Network Printing

Note:
The Status Monitor 
doesn’t appear if you’re 
printing over a network.
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Using the Spool Manager

The Spool Manager works like the Windows Print Manager. 
When you send a job to your printer, your printer software 
creates a temporary journal file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP folder or directory, and assigns it to a 
print queue. The software then sends the file to your printer at 
the right time.

◗ To open the Spool Manager while you’re printing, click 
the Spool Manager icon that appears on the Taskbar 
(Windows 95) or at the bottom of your desktop 
(Windows 3.1). 

◗ To open it at any time, double-click the Spool Manager4 
icon in the EPSON program group or folder.

You see the Spool Manager window:

The Spool Manager window displays the status of your print 
queues and journal files and lets you control them. 

Note:
In Windows 3.1, you 
may not see the Spool 
Manager icon if the 
Program Manager or 
current window is 
maximized. Make the 
window smaller to see 
the Spool Manager icon. 

menus

journal file
queue
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Here are some of the things you can do:

◗ Hold or release a queue

◗ Send journal files to your printer over a network 

◗ Hold, re-queue, or delete a journal file

◗ Select the information you want to see in the Spool 
Manager window

◗ Prevent the Despooler popup window from appearing on 
your screen whenever you print

◗ Change your default spool directory

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled 
print job. Follow these steps to delete it so you can continue 
printing:

1. Open the Spool Manager as described on page 4-2.

2. Click on any print jobs marked Held, then open the 
Document menu and click Delete. 

3. Click Yes.

4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing is 
very slow, you can try changing your default spool directory. 
Follow these steps:

1. Make a directory on your hard disk where you want Spool 
Manager to store journal files, for example, C:\SPLTEMP.

2. Open the Spool Manager as described on page 4-2.

3. Choose Default Spool Directory from the Options menu. 

For information about any 
of these procedures, use 
the Spool Manager Help 
menu.
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4. In the dialog box, change the spool directory to the one you 
created in step 1. Then click OK.

5. Make sure EPSON Stylus Photo is selected, and then choose 
Setup from the Queue menu. The Queue Setup dialog box 
appears.

6. Make sure the spool directory is the one you created in 
step 1. Also make sure Use Print Manager for this port is 
checked. Then click OK. (If you are using Windows 95 and 
don’t see the Status Monitor when you print, make sure it’s 
unchecked.)

7. Close Spool Manager.

Using the Status Monitor

The Status Monitor, available only if you’re using Windows 95, 
displays automatically when you send a job to the printer. 
However, you can use it at any time to see how much ink you 
have left. Follow these steps:

1. Access the Main printer settings dialog box as described on 
page 1-2.

2. Click the Utility tab.
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You see the Utility menu:

3. Click the EPSON Status Monitor icon.You see the 
Despooler window with the Status Monitor at the bottom:

4. Check the amount of ink you have left. For more 
information about the Despooler window, see page 1-5.

For information 
about these 
three utilities, 
see Chapter 5
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Managing Print Jobs on a 
Macintosh
Your Macintosh printer software includes two management 
utilities: Monitor2 and Status Monitor. 

◗ If you’re using background printing, Monitor2 starts 
automatically when you send a job to the printer. It handles 
printing while you continue to work on your Macintosh 
and lets you track documents that are waiting to be printed. 

◗ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it at any time to see how 
much ink you have left. 

Using Monitor2

The Monitor2 utility lets you continue to work on your 
Macintosh while your document is printing. However, 
background printing is slower and may also slow down your 
system. 

If you want to use this utility, you need to turn on background 
printing in the Chooser and increase the memory allocation for 
Monitor2. Follow these steps:

1. Open the Chooser from the Apple menu and select the 
EPSON Stylus(EX) icon. Then click either the printer or 
modem icon.

2. Under Background Printing, click On and close the 
Chooser.

3. To increase the memory allocated to Monitor2, select 
EPSON Monitor2 in the Extensions folder in your System 
folder.

4. Choose Get Info from the File menu.
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5. Under Memory Requirements, set the Prefered Size to 
3000K.

6. While you’re printing, click the EPSON Monitor2 icon on 
the Application menu at the right end of the menu bar. You 
see a dialog box like the following:

7. You can select a job and cancel it or just use this window to 
track the printer’s progress.

Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your 
printer and to control the way your software warns you about 
printer problems. Follow these steps:

1. Choose Print from the File menu or click the print icon in 
your application. You see the printer settings dialog box.

job currently 
printing

jobs queued 
for printing 
appear here
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2. Click the Utility button. You see the Utility menu:

3. Click the Status Monitor icon. The software checks the 
amount of ink remaining in the printer and displays the 
Status Monitor window:

4. If you want to change printer messages and warnings, click 
the Configuration button. 

For information 
about these 
three utilities, 
see Chapter 5

Click to recheck 
ink level

Click to control messages 
and warnings
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You see the following dialog box:

5. Choose the options you want and click OK.

Network Printing on a PC
You can use your printer on a network under Windows 95 or 
other network operating systems. The Spool Manager sends 
journal files from your computer to a shared directory on a 
network server. These files can then be printed from another 
computer attached to the printer. 

First you need to install the EPSON Stylus Photo printer 
software on each computer that is going to print on the 
network. Then run Spool Manager and identify the shared 
directory to use for journal files. After you set this up on the 
system connected to the printer (the host system), you need to 
perform a similar procedure on each remote system on the 
network. 

Under Windows 95, you also need to specify the port and 
network path to the printer.

Printing stops when 
these messages 
appear

Printing continues 
when these 
messages appear
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Setting Up the Host System

Follow these steps to set up the computer connected to the 
printer:

1. Create an icon for the EPSON Spool Manager 
(EPSPMGR4.EXE) in the \WINDOWS\SYSTEM folder.

2. Place this icon in the Startup folder.

3. Open the Spool Manager window as described on page 4-2.

4. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

5. Click the Remote Despool tab and then click the 
Printing from remote queues option.

6. Click the Browse button and select the remote server 
directory that will receive journal files.

7. Click OK and minimize the Spool Manager.

Setting Up Remote Systems

Follow these steps to set up computers on the network:

1. Create an icon for the EPSON Spool Manager 
(EPSPMGR4.EXE) in the \WINDOWS\SYSTEM folder.

2. Open the Spool Manager window as described on page 4-2.

3. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

4. Click the Spool to remote printer button.
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5. Click the Browse button and select the directory you’re 
using for journal files on the remote server.

6. Click OK and minimize the Spool Manager.

Setting Up Your Network Path in 
Windows 95

If you want to use your printer on a network running 
Windows 95, you need to set up the port and network path on 
the computer connected to the printer. Follow these steps:

1. Click Start, point to Settings, and then point to Printers.

2. Right-click the EPSON Stylus Photo icon and choose 
Properties.

Click the Details tab. You see the dialog box shown below:

3. Click the Add Port button, then specify the network path 
to the printer and click OK.
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4. Open the Spool Manager window as described on page 4-2.

5. In the Spool Manager window, double-click your printer’s 
queue. The Queue Setup dialog box appears.

6. Make sure the Use Print Manager for this port option is 
checked. Then click OK.
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It’s easy to keep your EPSON Stylus Photo printer working at its 
best. All you have to do is follow the simple instructions in this 
chapter for replacing ink cartridges, moving the printer, and 
performing routine maintenance. 

This chapter covers the following procedures:

◗ Cleaning the print heads

◗ Replacing an ink cartridge

◗ Aligning the print heads

◗ Cleaning the printer

◗ Transporting the printer

Cleaning the Print Heads
If your printed image is unexpectedly light or faint, or dots are 
missing from the image, you may need to clean the print heads. 
This unclogs the nozzles so they can deliver ink properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. You can use either of the following to clean the 
print heads:

◗ The Head Cleaning utility in your printer software (if the 
printer is on a local port rather than a network)

◗ The printer’s control panel buttons. 

Maintenance and
Transportation

Caution:
Don’t use the cleaning 
sheets that may be 
included with your 
special media; they may 
damage the printer.
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Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows computer 
or a Macintosh:

1. Make sure the printer is turned on but not printing, and 
the B black and A color ink out lights are off.

2. Access the Main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Head Cleaning icon.

5. Follow the instructions on the screen to clean the print 
heads. Cleaning takes about two minutes, during which the 
printer makes some noise and the Ppower light flashes. 

When the Ppower light stops flashing, you need to run a 
nozzle check.

6. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh). See page 5-3 for instructions on examining 
the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this four or five 
times, check the print quality solutions in Chapter 6.

Using the Control Panel

1. Make sure the printer is turned on and not printing, and 
that the B black and A color ink out lights are off.

2. Press the R cleaning button and hold it for three seconds. 
Cleaning takes about two minutes, during which the 
printer makes some noise and the Ppower light flashes. 

Caution:
Never turn off the printer 
while the Ppower light is 
flashing, unless the 
printer hasn’t moved or 
made any noise for more 
than 5 minutes.
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After the cleaning cycle is complete and the Ppower light 
stops flashing, you need to run a nozzle check. 

3. Access the Main printer settings dialog box as described in 
Chapter 1.

4. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

5. Click the Nozzle Check icon. See the next section for 
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this four or five 
times, check the print quality solutions in Chapter 6.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look 
something like this, with each of the six sections showing one of 
the ink colors:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If any dots are missing, clean the print 
heads again, as explained in the previous sections.

Replacing an Ink Cartridge
When a B black or A color ink out light flashes, the indicated 
cartridge is low on ink. This is a good time to make sure you 
have a new cartridge. When the light stays on, the cartridge is 
empty and you need to replace it.

Caution:
To ensure good results, 
use genuine EPSON 
cartridges and do not refill 
them. Other products may 
cause damage to your 
printer not covered by 
EPSON’s warranty.
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Use these EPSON ink cartridges within six months of installing 
them and before the expiration date on the package:

◗ Black ink cartridge: S020093

◗ Color ink cartridge: S020110

When you need new ink cartridges, contact your dealer or call 
EPSON Accessories at (800) 873-7766 (U.S. only). In Canada, 
please call (800) 873-7766 for dealer referral.

Removing an Empty Ink Cartridge

You can replace a cartridge when the B black or A color ink 
out light is either flashing or on. Follow these steps:

1. Make sure the printer is turned on and not printing. 

2. Determine which cartridge needs to be replaced.

3. Lower the output tray and raise the printer cover. 

4. Press the R cleaning button and hold it for three seconds. 

The print heads move slightly left and the P power light 
begins flashing. (The print heads return to their home 
position if you don’t proceed to step 5 within 60 seconds.)

5. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder. (Although the illustration shows the color ink 
cartridge, the procedure is the same for replacing the black 
ink cartridge.)

Caution:
If you press the R 
cleaning button when no 
ink out light is flashing or 
on, the printer cleans the 
print heads as described on 
page 5-2. If you need to 
replace an ink cartridge 
before the lights flash 
(because the ink is too old, 
for example) follow the 
instructions on page 5-7.
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6. Lift the cartridge out of the printer and dispose of it 
carefully. 

7. Follow the steps in the next section to install the new ink 
cartridge.

Installing the New Cartridge

Once you have removed the empty cartridge, you’re ready to 
install the new one. Follow these steps:

1. Remove the new ink cartridge from its packaging. 

Caution:
Don’t open the clamp or 
remove a cartridge 
except to replace it with 
a new one. Once you 
remove a cartridge, you 
can’t reuse it. Even if the 
cartridge contains ink, 
reusing it may damage 
the print head.

Warning:
If ink gets on your hands, 
wash them thoroughly with 
soap and water. If ink gets 
into your eyes, flush them 
immediately with water.
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2. Remove the yellow tape seal as shown:

3. Lower the ink cartridge into its holder with the label facing 
up and the arrow pointing to the back of the printer. The 
larger cartridge (color) goes on the right, the black ink 
cartridge on the left.

Caution:
You must remove the 
tape seal from the top of 
the cartridge; leaving the 
tape on will permanently 
damage it. Do not remove 
the clear seal from the 
bottom of the cartridge; 
ink will leak out.

black cartridge color cartridge
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4. Press down the ink cartridge clamp until it locks in place.

5. If you need to replace the other ink cartridge, remove it as 
described in “Removing an Empty Ink Cartridge” on 
page 5-4. Then follow steps 1 through 4 in this section.

6. Press the R cleaning button and close the printer cover.

The printer moves the print heads and begins charging the 
ink delivery system. (Even if you don’t press the button, ink 
charging begins 60 seconds after you close the clamp.)

The Ppower light flashes and the printer makes various 
sounds. Charging takes about two minutes. When it’s 
finished, you can print again.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may need 
to replace it. How can you tell? You may notice that your 
printouts don’t look as good as they used to. If print quality 
doesn’t improve after cleaning and aligning the print heads, you 
can replace one or both cartridges.

Caution:
Never turn off the printer 
while the P power light 
is flashing, unless the 
printer hasn’t moved or 
made any noise for more 
than 5 minutes.
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Follow these steps to replace an ink cartridge before the B black 
or A color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing.

2. Lower the output tray and raise the printer cover. 

3. Press the E load/eject button and hold it down for a few 
seconds until the print heads move to the left.

4. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder. 

5. Lift the cartridge out of the printer and dispose of it 
carefully. 

6. Follow the steps in the previous section, “Installing the 
New Cartridge,” to install the new ink cartridge.

Aligning the Print Heads
If your printouts contain misaligned vertical lines, you may 
need to align the print heads. Follow these steps:

1. Make sure the printer is turned on and paper is loaded.

2. Access the Main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print a test page 
and select the correct alignment.

Caution:
To avoid damaging the 
printer, never move the 
print heads by hand.
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Cleaning the Printer
To keep your printer working at its best, you should clean it 
several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

2. Remove all the paper from the sheet feeder.

3. Carefully clean away dust and dirt with a soft brush.

4. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

5. Clean ink out of the printer’s interior with a damp cloth.

Caution:
Don’t touch the gears 
inside the printer.

Never use alcohol or 
thinner for cleaning; they 
can damage the printer 
components and case.

Don’t use a hard or 
abrasive brush.

Don’t get water on the 
printer components.

Don’t spray lubricants or 
oils inside the printer.
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Transporting the Printer
If you want to move your printer some distance, you need to 
prepare it for transportation and repack it in the original box. 
Follow these steps:

1. Turn on the printer and wait until the print heads lock in 
the far right position. Then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then 
disconnect the interface cable from the printer.

3. Remove any paper from the sheet feeder and remove the 
paper support.

4. Push in the output tray extensions and close the tray.

5. Repack the printer and attachments in the original box 
using the protective materials that came with it. See the 
Notice Sheet that was packed with the printer.

Be sure to keep the printer flat as you transport it. If you notice 
a decline in print quality after transporting the printer, clean the 
print heads; if output is misaligned, align the print heads. See 
the instructions in this chapter.

Caution:
To avoid damage, always 
leave the ink cartridges 
installed when 
transporting the printer.
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As you use your printer, you may occasionally experience a 
paper jam or other problem. The first thing you should do is 
diagnose the problem, following the guidelines in this chapter. 
Then try the most likely solutions until the problem is fixed. 

This chapter tells you everything you need to know about the 
following:

◗ Diagnosing problems

◗ Improving print quality

◗ Solving printing problems

◗ Fixing paper jams and other paper problems

◗ Solving miscellaneous printout problems

Diagnosing Problems
Your printer includes a number of ways to help you diagnose 
problems:

◗ To identify the most common problems, check the lights 
on the printer’s control panel. See “What To Do When the 
Printer Lights Flash” on page 1-9.

◗ You can also use the Status Monitor utility to identify 
common problems. For instructions, see page 4-4 
(Windows 95) or page 4-7 (Macintosh).

Troubleshooting
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◗ To determine whether the problem is caused by the printer 
itself, run a printer operation check. See “Running a Printer 
Check” for instructions.

◗ For the latest information, check the EPSON Stylus Photo 
Help program and the ReadMe file in the EPSON program 
group or folder. 

◗ If none of the suggested solutions in this chapter solve your 
problem, contact EPSON as described under “Where to Get 
Help” in the Introduction.

Running a Printer Check

You can run a printer check to determine whether the problem 
comes from the printer itself or some other source. 

◗ If the results are satisfactory, the problem lies in software 
settings, the interface cable, or your computer.

◗ If the printer check does not print correctly, you have a 
problem with your printer. See the suggestions in this 
chapter for possible solutions.

Follow these steps to check the printer:

1. Make sure both the printer and computer are turned off.

2. Disconnect the interface cable from the printer.

3. Make sure paper is loaded in the printer.

4. Hold down the E load/eject button and press the Ppower 
button. Hold down the buttons until the Ppower light 
starts to flash. Then release both buttons.

The printer prints one page containing a nozzle check 
pattern (shown on page 5-3), the printer’s ROM version, 
ink counter code, and character table. 

5. After it prints the page, turn off the printer. Remember to 
reconnect the interface cable, then turn on the printer and 
your computer.
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Improving Print Quality
You can often improve print quality by doing one of the 
following:

◗ Clean the print heads (see Chapter 5 for instructions).

◗ Use higher quality paper appropriate for your print job (see 
Chapter 3 for a list of EPSON papers).

◗ Match the Media Type setting in the Main printer settings 
dialog box to the type of media you loaded in the printer 
(see Chapter 3 for details).

◗ Make sure High Speed mode is off (see Chapter 2 for 
details).

◗ Make sure Economy mode is off (see Chapter 2 for 
details).

◗ Replace the ink cartridges. (Check the status of the B black 
and A color ink out lights first. See Chapter 5 for 
instructions.)

Here are some detailed solutions to specific print quality 
problems.

The printed image has horizontal banding

Possible cause Solution

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 and 3.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 3 for instructions.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ink cartridges are low 
on ink.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5.

The MicroWeave (or 
Super MicroWeave) 
option is not set.

Turn on MicroWeave (or Super MicroWeave) in the advanced 
printer settings dialog box. See Chapter 2 for more information.
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Vertical lines are misaligned or vertical banding appears

The printed image has incorrect or missing colors

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

High Speed mode is 
turned on.

Turn off High Speed mode if vertical lines are misaligned. See 
Chapter 2 for information.

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 5 for 
instructions.

Possible cause Solution

The Ink option is set to 
Black.

Change the Ink setting to Color. See Chapter 1 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 and 3.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 3 for instructions.

The Halftoning and Color 
Adjustment Mode 
options are set incorrectly 
for your document type.

Use the correct settings for the project you’re printing, following 
the instructions in Chapter 2.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ICM (Windows 95) or 
ColorSync (Macintosh) 
settings are incorrect for 
your document.

Use the Automatic mode setting or choose a different project 
type or Rendering Intent setting. See Chapter 2 for more 
information.

The ink cartridges are low 
on ink or one or more ink 
colors are empty.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5 for instructions.

The colors displayed on 
your monitor don’t match 
the printed colors.

Because your monitor and printer use different technologies to 
represent colors, your printed colors cannot exactly match the 
colors you see on your monitor screen. Use the ICM (Windows 95) 
or ColorSync (Macintosh) settings. See Chapter 2 for more 
information.

The color settings in your 
application software need 
adjustment.

You may be able to adjust various color settings in your application 
software. See your software documentation for more information.
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The printed image is faint or has gaps

The printed image is blurry or smeared

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 and 3.

The loaded paper is 
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 3 for instructions.

The ink cartridges are low 
on ink.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5 for instructions.

Possible cause Solution

The printer’s thickness 
lever is in the 0 position.

Set the thickness lever to the + position and try printing again. See 
Chapter 3 for instructions.

The paper is damp or the 
printable side is face down.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 3 for instructions.

You loaded special media 
without a support sheet.

Follow the special media loading instructions in Chapter 3 and on 
the paper packaging for media that require support sheets. Also try 
loading your media one sheet at a time.

You tried to print on 
cardboard or other 
non-recommended media.

Make sure your paper or media meets the specifications listed in 
the Appendix. If your printouts are still blurry after you change 
paper, clean the print heads as described in Chapter 5.

The Media Type setting 
does not match the loaded 
paper.

Make sure the Media Type setting matches the media you loaded. 
Then the printer software can automatically select other settings 
for the best quality. See Chapter 3 for information.

The sheets entering the 
output tray are smearing 
the ink on ejected pages.

Remove each sheet from the output tray as soon as it is printed to 
prevent smearing, especially if you use transparencies. 

Ink has leaked inside the 
printer.

Clean carefully inside the printer to remove spilled ink. See 
Chapter 5 for instructions.

The color ink cartridge is 
empty.

Replace the color ink cartridge following the instructions in 
Chapter 5 or choose Black ink in your printer software.

You’re using the High 
Speed and MicroWeave 
settings with a misaligned 
print head.

Turn off High Speed following the instructions in Chapter 2. Run 
the Print head Alignment utility following the instructions in 
Chapter 5.
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Photographic images look grainy or rough

Color documents print in black and white

Solving Printing Problems
If the printer won’t print, first check that:

◗ The printer is turned on and the Ppower light is on.

◗ Paper is loaded in the printer.

◗ The printer is plugged into a working electrical outlet that’s 
not controlled by a switch or timer.

◗ The interface cable is securely connected to the printer and 
computer and both are turned on. 

If you still can’t print, check the following solutions.

All lights are off

Possible cause Solution

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 5 for 
instructions.

The resolution of your 
image may be too low.

Use the PhotoEnhance setting. You can also try to increase the 
image resolution using your image-editing software or decrease 
the size of the image.

Possible cause Solution

Your printer is not selected 
in your application.

Select your printer and port in your software application.

Color printing is not 
selected.

Select color printing in your application and the printer software.

Possible cause Solution

The printer is not receiving 
power.

Try these solutions:
◗ Make sure the printer is turned on.
◗ Turn off the power and plug in the power cord securely.
◗ Make sure the outlet is not controlled by a switch or timer and 

is operable.
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Only the P power light is on, but nothing prints

The S paper out light is flashing or on

Possible cause Solution

The interface cable is not 
connected securely.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications. (Use a 
fully shielded parallel cable on a PC or a Macintosh serial cable.)

The printer has an internal 
problem.

Turn off the printer and computer, disconnect the interface cable, 
and run a printer check as described on page 6-2.

Your printer software or 
application software is 
installed incorrectly.

If you ran a printer check successfully, make sure your printer and 
application software are installed correctly. If you’re printing on a 
Windows 95 network, you may need to set up your printer for 
network printing, as described in Chapter 4.

Your computer doesn’t 
have enough memory to 
handle the data in the file 
you are printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Printing is stalled in Spool 
Manager (Windows).

Delete the stalled print jobs in Spool Manager and resume printing; 
see Chapter 4 for instructions.

Your printer can’t use the 
modem port (Macintosh)

If your Macintosh has a built-in modem, connect the printer to the 
printer port.

Printing is stalled in 
Monitor2 (Macintosh).

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files.

The print heads are clogged 
or the ink cartridges are too 
old.

If the printer sounds like it’s trying to print but doesn’t feed paper, 
clean the print heads; see Chapter 5 for instructions. If cleaning 
doesn’t help, replace the cartridges. For information on cartridge 
life and replacement instructions, see Chapter 5.

Possible cause Solution

If flashing, paper is 
jammed.

Remove the paper and follow the guidelines for preventing jams 
on page 6-12.

If on, paper is used up or 
loaded incorrectly.

Load paper or remove the stack and reload it as described in the 
Quick Setup guide or Chapter 3. Then press the E load/eject button 
to turn off the light and resume printing.
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A B black or A color ink out light is flashing or on

The S and Plights are flashing

All the lights are flashing

The printer has finished charging the ink cartridge, but the Ppower light is still 

flashing

Possible cause Solution

If flashing, the ink supply is 
getting low.

You need to replace the indicated ink cartridge soon. Make sure 
you have a new cartridge, then see Chapter 5 for instructions.

If on, the ink cartridge is 
empty.

You must replace the indicated ink cartridge; see Chapter 5 for 
instructions.

Possible cause Solution

A carriage error has 
occurred.

Remove any paper in the printer. Press the E load/eject button for 
about 30 seconds. Then press it again. Turn the printer off, wait a 
few seconds, and then turn it on and try printing again. If the error 
is not cleared, contact EPSON as described in the Introduction.

Possible cause Solution

You haven’t removed all 
the packing material from 
the printer.

Remove the packing material, following the instructions on the 
Notice Sheet in the box. 

An internal error may have 
occurred. 

Turn off your printer, wait a few seconds, and turn it on again. If 
the lights still flash or stay on, contact EPSON as described in the 
Introduction.

Possible cause Solution

The ink cartridge clamp isn’t 
locked down.

Press down on the clamp to lock it into place.

Packing material remains in 
the printer.

Remove the packing material, following the instructions on the 
Notice Sheet in the box. 

The printer needs to 
initialize.

If the printer is not moving or making noise, but the light is still 
flashing for more than 5 minutes, turn the printer off. If the light is 
still flashing when you turn it back on, contact EPSON as 
described in the Introduction.
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The printer software installed with Windows 3.1 does not work correctly after you 

upgrade to Windows 95

After you install your printing software, you see the Windows 95 New Hardware 

found window

You see a spooling error message (Windows)

In Windows 95, the Status Monitor box does not appear with the Despooler

You see a type 11 or memory error message (Macintosh)

Possible cause Solution

Your printer software is not 
set up correctly for 
Windows 95.

Reinstall the printer software after installing Windows 95.

Possible cause Solution

An operating system error 
has occurred.

Click Do not install a driver, and then click OK.

Possible cause Solution

Spooling error messages or 
very slow printing may be 
caused by temporary files.

Change the Spool Manager default directory, following the 
instructions in Chapter 4.

Your hard drive is too full. Delete unnecessary files to make room on the drive.

Your computer doesn’t 
have enough memory for 
the file you’re printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Possible cause Solution

The Windows Print 
Manager is interfering with 
the Status Monitor.

Make sure Use Print Manager for this port is not checked in the 
Spool Manager Queue setup. See Chapter 4 for more information.

Possible cause Solution

You may need to increase 
the memory allocation for 
your application, EPSON 
Monitor2, or both.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor2).
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A portion of your image doesn’t print (Macintosh)

Printing is too slow

Your printer switches to the modem port or won’t confirm on the printer port 

(Macintosh)

Possible cause Solution

Your system doesn’t have 
enough available memory.

Close any other applications you are running or turn off 
background printing.

You may need to increase 
the memory allocation for 
your application, EPSON 
Monitor2, or both.

Choose Get Info from the File menu and increase the memory 
requirements. See Chapter 4 for more information. Or turn off 
background printing (you won’t be able to use Monitor2).

Possible cause Solution

Your printer software 
options are set incorrectly.

For faster printing, try the following:
◗ Set Print Quality to Economy.
◗ Turn MicroWeave off.
◗ Turn High Speed on.
◗ Choose No Halftoning.
◗ Choose Black ink.
See Chapters 1 and 2 for more information.

Your system doesn’t have 
enough resources.

◗ Clear space on your hard disk drive or run a defragmentation 
utility.

◗ Don’t run too many applications at the same time.
◗ Turn off virtual memory.
◗ Increase your system’s memory (RAM)

You’re using background 
printing on a Macintosh.

Choose Get Info from the File menu and increase the memory 
requirements for EPSON Monitor2. See Chapter 4 for more 
information. Or turn off background printing (you won’t be able to 
use Monitor2).

Your port settings are 
incorrect in Windows 95.

Change your default spool directory and disable port settings as 
described in Chapter 4.

Possible cause Solution

Your system has extension 
conflicts.

Make sure AppleTalk® is inactive. In the Extensions Manager, 
disable the AppleShare, FileShare, and PrinterShare extensions. 
Set your printer and any unused printers to the printer port. Then 
restart your system.

You’re using an AppleTalk 
cable.

Make sure you’re using a standard Apple System Peripheral-8 
cable, and it’s securely connected at both ends.
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Your printer icon doesn’t appear in the Chooser (Macintosh)

When you select your printer in the Chooser, you see a message that it can’t be 

used

You get a type 39 error on the Macintosh 

Fixing Paper Problems
You can avoid most paper handling problems by doing the 
following:

◗ Use smooth, high-quality media designed for ink jet 
printers that meets the media specifications in the 
Appendix.

◗ Follow all loading and handling instructions included with 
the media.

◗ Load the media with the printable side face up, as described 
in the Quick Setup guide or Chapter 3.

If you have problems with paper feeding, paper jams, or ejected 
paper, check here for solutions.

Possible cause Solution

Your system has extension 
conflicts.

In the Extensions Manager, disable Quick Draw GX. Make sure 
EPSON Monitor2 and EPSON Stylus Color are enabled, then restart 
your Macintosh.

Possible cause Solution

A system crash may have 
corrupted your printer 
software.

In your Extensions folder, delete EPSON Stylus (EX), EPSON 
Monitor2, and the EPSON folder. Then reinstall the printer driver 
software.

Possible cause Solution

You’re using System 7.5.2 Run a printer check as described on page 6-2. If the printer works 
correctly, remove and reinstall your printer driver software. To 
remove it, delete EPSON Stylus (EX), EPSON Monitor2, and the 
EPSON folder from your Extensions folder. Then reinstall the 
driver. You may also need to upgrade your system software.
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Paper doesn’t feed

Multiple pages feed at the same time

Paper jams inside the printer

Try this Then do this

Remove the stack of paper 
from the sheet feeder

Check that the paper:
◗ Isn’t curled or creased.
◗ Isn’t too old (see Chapter 3 or your paper packaging for more 

information).
◗ Isn’t loaded above the arrow on the left edge guide.
◗ Isn’t jammed inside the printer. (If the S paper out light is 

flashing, paper is jammed.)
Then reload the paper as described in Chapter 3, making sure the 
left edge guide is adjusted to fit the paper’s width.

Try this Then do this

Remove the stack of paper. ◗ Make sure the paper isn’t too thin (see the paper specifications 
in the Appendix).

◗ Fan the edges of the stack of paper to separate the sheets.
◗ Reload the paper as described in the Quick Setup guide and 

Chapter 3.
◗ If too many copies of a page or document are printing, check 

the Copies settings in both the printer settings dialog box and 
your application program. See Chapter 1 for more information.

Try this Then do this

Turn off your printer, open 
the cover, and remove all 
the paper that’s inside, 
including any small pieces 
that may have torn off. 

Reload the paper as described in the Quick Setup guide and 
Chapter 3. If your paper jams frequently, make sure you:
◗ Use smooth, high-quality paper, loaded printable side up.
◗ Fan the stack and then even the edges before loading it.
◗ Don’t load paper above the arrow mark on the left edge guide.
◗ Adjust the left edge guide to fit the width of your paper.
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Paper doesn’t eject fully or is wrinkled

Solving Miscellaneous Printout 
Problems
If your printout results are not what you expected, try these 
solutions.

Characters are incorrect or garbled

.

Possible cause Solution

If the paper doesn’t eject 
fully, you may have set the 
wrong paper size.

Press the E load/eject button to eject the paper. Then make sure 
you select the correct paper size in your application or printer 
software. (See the paper specifications in the Appendix for the 
paper sizes you can print with.)

If it’s wrinkled when it 
comes out, the paper may 
be damp or too thin.

See the paper specifications in the Appendix for paper thicknesses 
you can print with, as well as environmental requirements for 
storage.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup 
guide for instructions.

Printing is stalled in Spool 
Manager (Windows).

Delete the stalled print jobs in Spool Manager following the 
instructions in Chapter 4. Then try printing again.

If you’re using background 
printing on a Macintosh, 
spooled data may be 
corrupted.

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files. Increase the memory requirements for 
EPSON Monitor2, following the instructions in Chapter 4.

AppleTalk is activated on a 
Macintosh.

If your printer is connected to the printer port, open the Chooser 
and make sure AppleTalk is inactive.

The interface cable is not 
securely connected.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications.

You’re using a switch box 
with your printer.

Connect the printer directly to your computer and try printing 
again.
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The margins are incorrect

The image is inverted as if viewed in a mirror

The printer prints blank pages

Possible cause Solution

Margins are set incorrectly 
in your software 
application.

Check your software documentation for instructions on selecting 
the correct margins for your paper size. Make sure the margins are 
within the printable area of the page. See the Appendix for more 
information.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. Make sure 
the Printable Area setting is correct for your project. See Chapters 
1 and 3 for more information.

Possible cause Solution

You used a Flip Horizontal 
option in your application 
software or the printer 
software.

Turn off the Flip Horizontal or mirror setting in your application 
software or the printer software. See Chapter 2 for information.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup 
guide for instructions.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. See 
Chapter 1 for more information.

The print head nozzles are 
clogged.

Clean the print heads following the instructions in Chapter 5.
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Something on the page is wrong or missing

Possible cause Solution

Settings in your application 
software are incorrect.

Adjust the settings in your application

The interface cable in not 
connected properly.

Make sure the cable is securely connected to both the printer and 
computer.

You have the wrong port 
selected on your 
Macintosh.

If your Macintosh has only one serial port, open the Chooser, click 
the EPSON Stylus (EX) icon, and then select the modem port.

Your Macintosh has a 
built-in modem.

Connect the interface cable to the printer port. Then open the 
Chooser, click the EPSON Stylus (EX) icon, and then select the 
printer port.
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A
Printing

Printing method EPSON’s exclusive drop-on-demand Micro Piezo ink jet technology

Nozzle configuration 32 nozzles × 6 (black, cyan, magenta, yellow, light cyan, light 
magenta) 

Printable columns and 
printing speeds

20 inches per second (printable area 8.26 inches)

Resolution Maximum 720 dpi × 720 dpi

Print direction Bidirectional with logic seeking 

Control code ESC/P Raster™

Line spacing 1/6 inch, programmable in 1/360-inch increments

Paper feed speed 66.6 milliseconds per 1/6-inch line 

Input buffer 64KB

Character tables The characters for PC437 (US, Standard Europe) and PC850 
(Multilingual) can be selected using the following procedure:

When the printer is off, hold down the R cleaning button and press 
the P power button. Then release both buttons. This changes the 
character table to PC850. Repeat the procedure to change it back to 
PC437. You can run a printer check as described on page 6-2 to verify 
the current character table.

Specifications

Print quality Available dots

180 dpi 1488

360 dpi 2976

720 dpi 5952
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Paper 

Note: 
Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always test 
samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you 
encounter problems, switch to a higher grade of paper.

Do not load curled or folded paper.

EPSON ink jet papers and other special media are only usable under normal conditions:
Temperature: 59 to 77°F (15 to 25°C)
Humidity: 40 to 60% RH

Printouts on EPSON Photo Quality Glossy Film should be stored under the following conditions:
Temperature: 59 to 86°F (15 to 30°C)
Humidity: 20 to 60% RH

Paper type Size Paper types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
Legal (8.5 × 14 inches) 
Statement (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)

Plain bond paper and 
special ink jet papers 
distributed by 
EPSON

0.003 to 0.004 inch 
(0.08 to 0.11 mm) 

17 to 24 lb 
(64 to 90 g/m2)

Transparencies,

Glossy film, 

Glossy paper

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy 
film only)
Photo paper (4 × 6 inches)

Transparencies, 
glossy paper, and 
glossy film 
distributed by 
EPSON

Adhesive 

sheets

A4 (210 × 297 mm) Self adhesive sheets 
distributed by 
EPSON

Envelopes No. 10 9.5 × 4.1 inches 
(240 × 104 mm) 

DL 8.7 × 4.3 inches 
(220 × 110 mm) 

C6 4.4 × 6.4 inches 
(114 × 162 mm)

Plain bond paper or 
air mail paper

0.006 to 0.017 inch 
(0.16 to 0.43 mm)

12 to 20 lb 
(45 to 75 g/m2)

Index cards A6 (105 × 148 mm)
5 × 8 inches (127 × 203 mm)
10 × 8 inches (254 × 203 mm)

Ink jet cards 
distributed by 
EPSON
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Printable area

A: The minimum top margin is 0.12 inch (3.0 mm).

When loading multiple sheets of EPSON Photo Quality Glossy Film, the minimum top margin is 1.2 
inches (30 mm).

B: The minimum left margin is 0.12 inch (3.0 mm).

The minimum right margin for letter and legal size paper is 0.35 inch (9.0 mm). The minimum right margin 
for other sizes of paper is 0.12 inch (3.0 mm).

The minimum right margin for envelopes is as follows:
0.28 inch (7 mm) for DL envelopes.
1.10 inches (28 mm) for No. 10 envelopes.
0.12 inch (3 mm) for C6 envelopes.

C: The minimum bottom margin is 0.54 inch (14.0 mm).

Note:
Always load paper into the sheet feeder short edge first. However, envelopes should be loaded 
long edge first.

A

B-L
B-R

C

A

B-R
C

B-L

EnvelopeSingle sheet
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Ink Cartridge

* The print capacity may vary, depending on how often you use the print head cleaning function.

** It thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
To ensure good results, use genuine EPSON ink cartridges. Other products may cause damage 
to your printer not covered by EPSON’s warranty.

Don’t use an ink cartridge if the date on the package has expired.

Mechanical
Paper feed method Friction

Paper path Sheet feeder, rear entry

Sheet feeder capacity 100 sheets at 17 lb (64 g/m2) paper

Dimensions

Storage Width: 16.9 inches (429 mm) 
Depth: 10.8 inches (275 mm) 
Height: 6.6 inches (168 mm)

Printing Width: 16.9 inches (429 mm) 
Depth: 24.1 inches (613 mm) 

27.4 inches (695 mm) when printing transparencies
Height: 12.2 inches (309 mm)

7.7 inches (196 mm) when printing transparencies

Weight 11.5 pounds (5.2 kg) without the ink cartridges

Specification Black ink cartridge (S020093) Color ink cartridge (S020110)

Color(s) Black Cyan, Magenta, Yellow, Light Magenta, 
Light Cyan

Print capacity* 540 pages/A4 (ISO/IEC 10561 Letter Pattern 
at 360 dpi)

190 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date (if unopened)
(within 6 months after opening package, at 77 °F (25 °C))

Storage 
temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit 
temperature

–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 
temperature**

3.2 °F (–16 °C) –0.4 °F (–18 °C)

Dimensions 0.7 (W) × 2.1(D) × 1.5 (H) inches
19.8 (W) × 52.7(D) × 38.5 (H) mm

2.0 (W) × 2.1(D) × 1.5 (H) inches
51.4 (W) × 52.7 (D) × 38.5 (H) mm
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Electrical

Note: 

Check the label on the back of the printer for the voltage of your printer.

Environmental
Temperature Operation: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 140 °F (–20 to 60 °C), stored in shipping container 
1 month at 104 °F (40 °C) 
120 hours at 140 °F (60 °C)

Humidity Operation: 20 to 80% RH (without condensation)
Storage: 5 to 85% RH (stored in shipping container, without 
condensation)

Safety Approvals
Safety standards UL 1950 with D3, CSA C22.2 No.950 with D3

EMC FCC part 15 subpart B class B, CSA C108.8 class B

Interface Your printer is equipped with an 8-bit parallel interface and a serial 
interface.

Parallel interface The built-in parallel interface has the following characteristics:

Forward channel Data format: 8-bit parallel, IEEE-1284 compatibility mode

Synchronization: STROBE pulse

Handshake timing: BUSY and ACKNLG signals

Signal level: TTL compatible

Connector: 57-30360 Amphenol connector or equivalent

Specification 120V Model 220−240V Model

Input voltage range 103.5 to 132V 198 to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 15W (ISO/IEC 10561 Letter Pattern)
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Reverse channel Transmission mode: IEEE-1284 Nibble mode

Adaptable connector: 57-30360 Amphenol Connector or equivalent

Synchronization: Refer to the IEEE-1284 specification

Handshaking: Refer to the IEEE-1284 specification

Signal level: IEEE-1284 Level 1 device

Data transmission timing: Refer to the IEEE-1284 specification

Serial interface The printer’s built-in serial interface is based on the RS-423 standard. 
This interface has the following characteristics: 

Standard: Based on RS-423

Synchronization: Synchronous

Bit rate: Approx. 900 Kbps

Handshaking: X-ON/X-OFF DTR protocol

Word format: 
Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector: 8-pin mini-circular connector

Recommended cable: Apple System Peripheral-8 cable (Part number 
M0197)

Initialization The printer can be initialized (returned to a fixed set of conditions) in     
these ways:

Hardware 
initialization

When the printer is turned on, the printer mechanism is initialized, 
the input and print buffers are cleared, and all settings return to their 
default values. However, the printer mechanism is not initialized if the 
printer is turned on within 10 seconds after being turned off. In this 
case, the printer caps the print head, and ejects any paper in the paper 
path.

Software 
initialization

Software initialization clears the print buffer and returns all settings to 
their default values. However, software initialization does not initialize 
the printer mechanism or clear the data buffer.

Hardware 
initialization

∗ The printer is turned on.
∗ The printer receives an INIT signal from the parallel
   interface.

Software 
initialization

∗ Software sends the ESC @ (initialize the printer) command.
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Glossary

banding The horizontal lines that sometimes appear in a printed image. 
See also MicroWeave.

bidirectional Moving the print head from left to right and right to left, for 
faster output.

buffer The portion of the printer’s memory used to store data before 
printing it.

character table A collection of letters, numbers, and symbols that provides you 
with the characters used in a particular language.

CMYK Cyan (blue-green), magenta, yellow, and black. These colored 
inks are used to create printed colors. The addition of light 
magenta and light cyan increases the accuracy of photographic 
images for virtual continuous-tone printing. 

ColorSync Macintosh software that is designed to help you get WYSIWIG 
(what you see is what you get) output. This software prints 
colors as you see them on your screen.

default A value or setting that takes effect when the equipment is 
turned on, reset, or initialized.

dithering A halftoning method in which dots are arranged in an orderly 
pattern. Dithering works best for printing images with solid 
colors, such as charts and graphs. See also halftoning.

dpi Dots per inch. The dpi measures the resolution. See also 
resolution.

driver A software program that sends instructions to a computer 
device to tell it what to do. For example, your printer driver 
accepts print data from your image processing application and 
sends instructions to the printer on how to print this data.
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Error Diffusion This halftoning setting smooths out edges by randomly placing 
dots of varying colors. This has the opposite effect of the Finest 
Detail setting.

ESC/P Raster A version of the ESC/P (Epson Standard Code for Printers) 
command language, which gives you control of your printer 
from your computer. Commands in this language produce 
enhanced graphics printing.

Finest Detail This setting automatically makes your printed images sharper 
and clearer. This has the opposite effect of the Error Diffusion 
setting. Be aware that this may increase the time required for 
printing.

font A style of type designated by a name.

gamut The range of colors that a device (such as a printer or monitor) 
can accurately reproduce.

grayscale A scale of shades of gray from black to white. Grayscale is used 
to represent colors when printing with black ink only.

halftoning A method of using dot patterns to represent an image. 
Halftoning makes it possible to produce varying shades of gray 
using only black dots, or a nearly infinite array of colors using 
only a few colors of dots.

host system The computer connected directly to the printer in a network. 

initialization Process that returns the printer to its defaults (fixed set of 
conditions). This happens every time you turn on or reset the 
printer.

ink jet A method of printing in which images, lines, letters, or symbols 
are formed by precisely spraying ink onto paper.

interface The connection between the computer and a peripheral such as 
a printer. Some printers have two interfaces, parallel and serial. 
A parallel interface transmits data one byte, or eight bits, at a 
time. A serial interface transmits data one bit at a time.
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media Materials upon which data is printed, such as envelopes, plain 
paper, special paper, and transparencies.

Micro Piezo Ink jet technology that uses an electronic pulse to precisely force 
the ink through the print head. This results in smaller, cleaner 
dots, sharp lines, and crisp text.

MicroWeave Printing technology that produces images in fine increments to 
reduce the possibility of banding. See also banding.

parallel interface See interface.

print queue Print jobs that are sent to the printer while it is busy are stored 
in a waiting line, or print queue, until they can be printed.

print server The computer connected to the printer. It receives the jobs and 
then distributes them to the assigned printer. It also holds extra 
print jobs while the printer is busy. See also print queue. 

printable area The area of a page on which the printer can print. It is smaller 
than the physical size of the page due to margins. 

printer driver See driver.

RAM Random Access Memory. The area of your computer’s memory 
that runs programs and stores data.

reset To return a printer to its defaults either by sending a command 
or an INIT signal, or by turning the printer off and then back 
on.

resolution The number of dots per inch used to represent an image.

ROM Read Only Memory. Memory area in your printer or computer 
that cannot be modified. ROM retains its contents when you 
turn off the printer or computer.

saturation The depth or vibrancy of a color; the amount of gray.

serial interface See interface.
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spool The process by which the printer driver converts the print data 
into codes that your printer understands. This data is then sent 
to the printer directly or to the print server.

Spool Manager An EPSON software program that converts print data into codes 
that your printer understands. See also spool.

Status Monitor An EPSON software program that displays the printer’s status, 
such as paper out or the amount of ink remaining before 
printing.
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Index

A Advanced mode, selecting, 
2-1 to 2-3

Advanced settings
custom, 2-4 to 2-6
predefined, 2-1 to 2-4

Aligning print heads, 5-8, 6-4
Automatic mode, 1-3, 1-7

B Background printing, Macintosh, 
4-6

Banding, 6-3 to 6-4
Blank pages, 6-14
Blurry printouts, 6-5
Brightness setting, 2-8

C Cards, see Photo Quality Ink Jet 
media

Characters, garbled, 6-13
Cleaning

print heads, 5-1 to 5-3
printer, 5-9

Cleaning sheets, 3-3
Color Adjustment modes, 2-8
Color problems, 6-4
Colorimetric setting, 2-10
ColorSync, 2-3, 2-7 to 2-11
CompuServe, 6
Contrast setting, 2-8
Control code, A-1
Control panel

lights, 1-9
using, 1-9, 6-6 to 6-8

Custom paper size, 3-9 to 3-13

Custom settings
color, 2-7 to 2-9
print quality, 2-4 to 2-6
project types, 2-3
saving, 2-11
special effects, 2-4 to 2-6

Customer Care Centers, 4
Cyan setting, 2-8

D Default printer options, setting, 
1-4

Deleting print job, 4-3
Despooler, 1-5, 4-5
Dithering, 2-5
Draft printing, 2-3

E Economy setting, 2-3
Electrical specifications, A-5
ENERGY STAR, 6
Energy-saving tips, 7
Envelopes

printing, 3-7
specifications, A-2, A-3

Environmental specifications, A-5
EPSON

Accessories, 5
Customer Care Centers, 4
Electronic Support Services, 

5 to 6
help, 4 to 6
media, 1-8, 3-1 to 3-2
World Wide Web site, 5
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F Faint printouts, 6-5, 6-6
Fax-on-Demand, 6
Film, see Photo Quality Glossy 

media
Flip Horizontal setting, 6-14
Forms, printing, 3-3

G Glossy media
choosing, 1-8
printing, 3-5 to 3-6
specifications, A-2

H Halftoning setting, 2-5
Head Cleaning utility, 5-2
Help, 4 to 6
Horizontal banding, 6-3

I ICM (Image Color Matching), 2-3, 
2-7 to 2-9

Index cards, see Photo Quality Ink 
Jet media

Initialization, A-6
Ink cartridge

replacing, 5-3 to 5-7
specifications, A-4

Ink jet cards
choosing, 1-8
printing, 3-8
specifications, A-2

Ink jet paper
choosing, 1-8
printing, 3-3, 3-4
specifications, A-2

Ink level, 1-5, 4-5, 4-8
Ink setting, 2-5
Interface specifications

parallel, A-5
serial, A-6

Internet, 5
Iron-On Transfer Paper

choosing, 1-8
printing, 2-6, 3-8

J Jammed paper, 1-9, 6-12
Journal files, 4-2, 4-10

L Legal-size paper, 3-3
Letterhead, 3-3
Lever, thickness, 3-7
Lights, using, 1-9, 6-1, 6-6 to 6-8

M Macintosh
interface specifications, A-6
managing print jobs from, 

4-6 to 4-9
Monitor2, 4-6
printing from, 1-6 to 1-7
system requirements, 2

Magenta setting, 2-8
Maintaining printer, 5-1 to 5-9
Managing print jobs

Macintosh, 4-6 to 4-9
Windows, 4-1 to 4-5

Margins
problems, 6-14
specifications, A-3
with multiple sheets, 3-6

Mechanical specifications, A-4
Media Type setting, 1-3, 1-7,  

3-1 to 3-2
MicroWeave setting, 2-6
Mirror images, 2-6
Monitor2, 4-6
Moving printer, 5-10

N Network
path, 4-11
printing, 4-9 to 4-12

Nozzle Check
pattern, 5-3, 6-2
utility, 5-2 to 5-3
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P Panoramic images
loading paper, 3-9
printing from Macintosh, 

3-11 to 3-13
printing from Windows, 

3-10 to 3-11
Paper

coated, 3-2
glossy, see Photo Quality Glossy 

media
handling problems, 

6-11 to 6-13
legal, 3-3
letterhead, 3-3
photo, see Photo paper (4 × 6)
plain, 3-2
specifications, A-2 to A-3
support, 3-5
tab, 1-3
thickness lever, 3-7
types, 1-3, 1-7 to 1-8

Paper jams, 1-9, 6-12
Paper size, custom, 3-9 to 3-13
Perceptual setting, 2-10
Photo paper (4 × 6), 3-4 to 3-5
Photo Quality Glossy media

choosing, 1-8
printing, 3-5 to 3-6
specifications, A-2

Photo Quality Ink Jet media
choosing, 1-8
printing, 3-3, 3-4, 3-8
specifications, A-2

Photo setting, 2-3
PhotoEnhance, 2-3, 2-8, 2-9, 6-6
Predefined advanced settings, 

2-1 to 2-4
Print Head Alignment utility, 6-4
Print heads

aligning, 5-8
cleaning, 5-1 to 5-3

Print job, deleting, 4-3
Print quality problems, 6-3 to 6-6
Print Quality setting, 2-5
Print queue, 4-3
Printable area, A-3

Printer driver, accessing
Control Panel, 1-4
Settings option, 1-4
Windows applications, 1-2

Printer check, 6-2
Printer status, Windows, 1-5
Problems

diagnosing, 6-1 to 6-2
paper handling, 6-11 to 6-13
print quality, 6-3 to 6-6
printing, 6-6 to 6-11
solving, 6-1 to 6-15
unexpected printout results, 

6-13 to 6-15

Q Quality/Speed setting, 1-3

R Rendering Intent setting, 2-10
Replacing ink cartridges, 5-3 to 5-7
Resolution, 2-5, A-1

S Safety
approvals, A-5
instructions, 7 to 9

Saturation setting, 2-8, 2-10
Self adhesive sheets

choosing, 1-8
printing, 3-8
specifications, A-2

Self test, 6-2
Service, 4 to 6
Smears, 3-7, 6-5
Specifications

electrical, A-5
environmental, A-5
ink cartridge, A-4
interface, A-5 to A-6
mechanical, A-4
paper, A-2 to A-3
printing, A-1

Spool directory, 4-3
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Spool Manager
problems, 6-7, 6-9, 6-13
using, 4-2 to 4-4

Status Monitor
Macintosh, 4-7 to 4-9
problems, 6-1, 6-9
Windows, 1-5, 4-4 to 4-5

Support, EPSON, 4 to 6
System requirements, 2

T Technical specifications, 
A-1 to A-6

Testing printer, 6-2
Text/Graph setting, 2-3
Thickness lever, 3-7
Transparencies

choosing, 1-8
printing, 3-5 to 3-6
specifications, A-2

Transporting printer, 5-10
Troubleshooting, 6-1 to 6-15
T-shirt transfer paper, 3-8

U User Defined paper size, 3-11
Utilities

Head Cleaning, 5-2
Nozzle Check, 5-2 to 5-3
Print Head Alignment, 5-8

W Windows
managing print jobs from, 

4-1 to 4-5
printing from, 1-1 to 1-3
Spool Manager, 4-2 to 4-4
System requirements, 2

Windows 95, ICM, 2-7 to 2-9
World Wide Web, 5

Y Yellow setting, 2-8
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